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1 General 
1.1 Warranty, Liability and Support 

The Safety Evaluation Tool is provided to you free of charge. Therefore, no warranty is 
granted for the present report with the exception of willful or fraudulent behavior. This 
particularly applies to the tool’s correctness, freedom from errors, completeness and 
usability.  
Use of the Safety Evaluation Tools is voluntary and subject to your own risk. As far as 
Siemens provides technical support with the tool’s use or with report generation, such 
support is granted on a voluntary basis and without acknowledgement of any statutory 
duty. 
With the exception of personal injury, the liability of Siemens and its vicarious agents 
is generally limited to cases of intent and gross negligence and to the extent of 
foreseeable and typical damage. 

1.2 Description of the Functionality 

The SIEMENS Safety Evaluation Tool provides valuable support with the rapid and 
easy assessment of safety functions in machines and systems.  
The TÜV-tested online tool offers step-by-step user guidance, from specification of the 
safety system’s structure, to component selection, down to the determination of the 
attained safety integrity in accordance with ISO 13849-1 and IEC 62061. This is also 
supported by the comprehensive integrated libraries.  
As a result, the user is provided with a standard-compliant report, which can be 
integrated in the documentation as safety proof. 
Online access to the Safety Evaluation Tool ensures that the calculations are always 
carried out on the basis of the currently applicable standards and the continuously 
updated technical data of all safety-relevant components by SIEMENS.    

1.3 Prerequisites 

A previously conducted risk analysis which defines the required safety functions forms 
a prerequisite for the Safety Evaluation Tool’s application. Here, generally the logical 
functions with the already envisaged hardware sub-functions (e.g. detection, 
evaluation and reaction) are to be selected. 
Furthermore, the persons in charge (project manager and project inspector) of the 
final acceptance tests have to be named. 

1.4 Important Notes 

The Safety Evaluation Tool is an online tool. All created projects are only saved locally 
on your PC. The project data are not saved on the Siemens online server. 
If no entries are made for a period exceeding 30 minutes, the online connection will be 
interrupted after display of a respective note. In this case, any unsaved projects / 
changes will be deleted. 
Therefore, please regularly save your project data via File > Save projects or by 
clicking the  field. 
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2 Call-Up of the Safety Evaluation Tool 
2.1 Link to the Safety Evaluation Tool 

www.siemens.com/safety-evaluation-tool 
 

2.2 Registration 

 
 
Upon first call-up of the Safety Evaluation Tool, you are requested to register yourself. 
Please fill in the registration mask completely (* = mandatory field). Please observe 
that these entries appear in the Safety Evaluation Tool and in the report under Last 
editor. 
Following registration, you will receive an e-mail containing your access data (login 
name and password) for further use of the Safety Evaluation Tool. 
The subsequent first-time registration process comprises some questions which are 
aimed at better matching our products to your needs in the future. 
Of course, the Safety Evaluation Tool’s use is free of charge. 
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3 Operation of the Safety Evaluation Tool 
The sections below describe the general functional principle of the Safety Evaluation 
Tool on the basis of an example. 

3.1 Font Sizes of Masks 

The font sizes of the masks can be changed in the Internet Explorer via View > Zoom 
or Text size. 

3.2 Layout of Masks 

 
 

The masks of the Safety Evaluation Tool are divided into four general sections: 
1. General buttons: 

• File Pull-down menu with the following sub-items: 
o New workspace: Deletes the entire workspace under User 

projects 
o Load projects: Loads and opens a locally saved project under 

User projects 
o Import project: Loads and adds a further project to the 

currently open project (under User projects) 
o Save projects: Locally saves the open project or several 

projects under User projects to a file (*.set); alternatively, the 
project can also be saved by clicking the  
field 

• Project Pull-down menu with the following sub-items: 
o Creation of New IEC 62061 project  
o Creation of New ISO 13849-1 project  
o Creation of New safety area  
o Creation of New safety function  
o Creation of New subsystem or SRP/CS  
o Export project  

• Copy selection: Copies the selected component (tree node under 
Library or User projects) to the cache 

• Paste selection: Pastes the component from the cache (tree node under 
User projects) 
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• Delete selection: Deletes the selected component (tree node under User 
projects) 

• Create report: The result report of the currently selected project is 
created via this button 

• Options: Activates or de-activates the display of the product actuality in 
the project tree 

• Getting Started: Link to this document 
• Terms: Link to the reference “Safety Integrated, Terms and Standards” 

with terms and background information on the relevant standards  
• Forum: Link to the "Safety Evaluation Tool" online forum for questions, 

suggestions and additional information 
 
2. Navigation tree for Library (example projects pre-defined by SIEMENS) and 

Projects (customer projects) 
The symbols in the navigation tree have the following meaning: 

•   By clicking this symbol, all elements and their sub-levels are displayed  
•   By clicking this symbol, all elements and their sub-levels are minimized  
•   Further elements are available under the element, which are displayed 

by clicking the arrow  
•   The elements available under the element are displayed; they can be 

minimized by clicking the arrow  
•   Lowermost level of the project 
•   Required entries are missing under the tree node  
•   The function does not meet the required SIL or PL 

•  Product update information is available (e.g. product can no longer be 
ordered). For more details, select the corresponding product 

 
3. Workspace in which all required entries are made  
 
4. Section for display of the current login name; language selection of the Safety 

Evaluation Tools via the  symbol. User change via  
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3.3 Library 

Typical example projects, which can be used as basis for your own projects, are 
available under Library. 
 

3.3.1 Inserting Safety Functions from Libraries   

To insert a safety function from a library in User projects, proceed as follows: 
• Select the exemplary safety function in accordance with the respectively 

applicable standard in Library  
• Operate the Copy selection button  
• Create a new project under User projects or select an existing project 
• Create a new safety area in this project or select an existing safety area  
• Select this safety area 
• Operate the Paste selection button  

3.3.2 Inserting Sub-Systems or SRP/CS from Libraries  

Besides complete safety functions, also only individual sub-systems or SRP/CS can 
be inserted in User projects from a Library. The procedure is as follows: 

• Select the exemplary sub-system or SRP/CS in accordance with the 
applicable standard in Library  

• Operate the Copy selection button 
• Create a new project under User projects or select an existing project 
• Create a new safety area in this project or select an existing safety area  
• Create a new safety function in this safety area or select an existing safety 

function  
• Select the respective level (DETECTION, EVALUATION or REACTION)  
• Operate the Paste selection button 
• Delete the sub-system or SRP/CS, which was automatically inserted and may 

no longer be required after copying, in User projects  
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3.4 Creating User Projects 

Note The locally saved file is not changed by loading, copying and deleting.  

The local file (*.set) is only overwritten with the current data upon saving.  

3.4.1 Loading Existing Projects 

Already created projects can be loaded locally from a *.set file (e.g. from your PC’s 
hard disk or a company-internal server) via File > Load projects. These projects can 
be subsequently further edited or used as basis for new projects. 

3.4.2 Adding an Existing Safety Area / Function  

To add a safety area or a safety function from a previously created project to an open 
project, proceed as follows: 

• Operate Load > Import project and select the respective project with the 
desired safety area or the desired safety function   

• After insertion of the project, select the desired safety area or safety function 
via Copy selection  

• Insert the safety area or safety function in your project via Paste selection  
• The project no longer required can be subsequently deleted via Delete 

selection  

3.4.3 Creating a New Project 

To create a new project, select User Projects and operate the  button. 
Select the applicable standard for this project in the automatically opened dialog. 
 

 
 
IEC 62061 is used for this example. 
The next chapters feature a step-by-step description of the Safety Evaluation Tool’s 
individual masks and the required entries. Masks which differ due to general 
differences in the standards are illustrated consecutively.  
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3.4.4 Project - General Description Editing 

 The term project refers to the summarization of one or several safety areas and 
safety functions of a system or machine.  
 

 
 
The following information on the project has to be entered under Project – General 
description: 

• Name of the project 
• Manager for the project 
• Inspector for the project 
• System type 
• Name of the Document for risk assessment 
• Description of the project 

Then, operate the  button under Further functions. 
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3.4.5 Safety Area – General Description Editing 

 The term safety area refers to a grouping of several safety functions of a project or 
system. At least one safety area is required. 
A safety area helps to “structure” your machine in order to assign the safety functions 
to specific system sections. 
 

 
 
The following information on the safety area has to be entered under Safety area – 
General description: 

• Name of the safety area 
• Description of the safety area 

 

Then, operate the  button under Further functions. 
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3.4.6 Creating a New Safety Function, Layout Definition 

Prior to creating the safety function, the safety function’s layout has to be defined. 
To ease further entries, the combinations below are available in addition to the 

standard layout of  (consisting of three 
sub-systems or SRP/CS): 

•  With this combination, the 
detection and evaluation sub-functions are summarized and only devices 
which combine these function are suggested to you (e.g. SIRIUS standstill 
monitor 3TK2810). 

•  With this combination, the 
evaluation and reaction sub-functions are summarized and only devices which 
combine these functions are suggested to you (e.g. frequency converter 
SINAMICS G120). 

•  With this combination, the three 
sub-functions are summarized and only devices which combine these 
functions are suggested to you (e.g. safety light curtain). 

 

 
 

This Getting Started uses the standard layout 

. Confirm the selection via the  
button. 
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3.4.7 Safety Function – General Description Editing 

 The term safety function refers to a summarization of the individual sub-systems or 
SRP/CS under DETECTION, EVALUATION and REACTION. 
 

 
 
The following information on the safety function has to be entered under Safety 
function – General description: 

• Name of the safety function 
• Operation mode valid for this safety function 
• Inspector of the safety function 
• Description of the safety function 
• Status of the safety function’s assessment 
• Version of the safety function’s assessment 

 

Note The Last editor, who is automatically assigned upon login (first name and 
surname), cannot be edited. . 

With loaded projects, the Last editor is only overwritten by the currently 
registered user of the Safety Evaluation Tool when project changes are saved.  

 
The safety function’s safety integrity now has to be selected in accordance with the 
selected standard. 
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3.4.7.1 IEC 62061; Consideration of Safety Integrity: 

Select the Required SIL in accordance with the implemented risk analysis or 

determine the required SIL by operating the  button. 
 

 
 

Then, select the Sensor – group in the navigation tree under DETECTION. 
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3.4.7.2 ISO 13849-1; Consideration of Safety Integrity: 

Select the Required PL in accordance with the implemented risk analysis or 

determine the required PL by operating the  button. 
 

 
 
Then, select the Sensor – group in the navigation tree under DETECTION. 

Safety Evaluation Tool  
Getting Started V2.0 

14/25



3.4.8 Sensor Group (ES Pushbutton) Editing 

In the Sensor group mask, the properties of the sensor (e.g. EMERGENCY-STOP 
commanding device) for activation of the safety function have to be defined.  
The mask layout and values to be entered differ depending on the used standard.  

 
 
The general presettings of the mask are as follows: 

• Name of the sensor group 
• Type of the sensor 

o Customer data required (wear component) 
o SIL / PL exists (electronic component) 

• When selecting Customer data required, using the pull-down menu, 
Architecture of the sensor group (1 or 2-channel) must be selected. 

• When selecting Customer data required, using the pull-down menu, the No. 
of components must be edited. 

o 1-channel architecture  1 component 
o 2-channel architecture 

 1 component (channels 1 and 2 are identical) 
 2 components (identical or different types) with different 

values (e.g. different actuation cycle) 
• Manufacturer of the sensor 

o When selecting Siemens, the appropriate Siemens sensors are 
recommended with the safety-relevant data.  

o When Third-party manufacturer is selected, the safety-relevant data 
of the sensor can be freely entered.  

o The two versions are subsequently explained in detail. 
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Option 1: Manufacturer = Siemens  
 

 
 
Complete all of the fields displayed below. Help when completing the fields is available 
using the tool tips for these fields and the  button 

• To determine the DC and the CCF factor, the corresponding selection screen 
forms are available (  or  button) 

• S7 connection (only for sensors without integrated communication 
connection), using this field, you can specify whether the sensor is 
connected to a fail-safe PLC via a fail-safe digital input module. When 
activated, under EVALUATION, a partial system and/or SRP/CS is created for 
the fail-safe digital input module. 

• Structural restriction (only for IEC 62061):  
o The selection Yes or Position switch limits the SIL CL to 2 
o The selection None or Emergency Stop does not limit the SIL CL 
o Also see  

 
Then, in the navigation tree, under EVALUATION, select S7 – ES Pushbutton. 
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Option 2: Manufacturer = Third-party manufacturer  
 

 
 
Complete all of the fields displayed below. Help when completing the fields is provided 
using the tool tips to the fields and the  button. You can obtain the corresponding 
values from the component supplier. 

• In the field next to Third-party manufacturer, enter the manufacturer’s name 
• Under Fault rate calculator you can select which value should be used to 

calculate the fault rate. The fault rate can be calculated using: 
o B10 
o B10d 
o MTTF 
o MTTFd 
o MTBF 
o λD 

• To determine the DC and the CCF-Factor, the corresponding selection 
screen forms are available (  or  button) 

• Structural restriction (only for IEC 62061):  
o The selection Yes or Position switch limits the SIL CL to 2 
o The selection None or Emergency Stop does not limit the SIL CL 
o Also see  

 
Then, in the navigation tree under EVALUATION, select Logic - group. 
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3.4.9 Logic Group (S7 – ES Pushbutton) Editing 

Due to selection of the S7-Connection in the Sensor group, a sub-system or SRP/CS 
was automatically created for the failsafe digital input module under EVALUATION. 
The mask layout and values to be entered differ depending on the used standard. 
 

 
 
 

Fill in all fields. Help is provided by the tool tips on the fields and via the  button. 
 

Then, select the Logic – group in the navigation tree under EVALUATION. 
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3.4.10 Logic Group (S7 – Controller) Editing 

In the Logic group mask, the properties of the safety function’s evaluation logic (e.g. 
safety relay, failsafe CPU) have to be defined.  
The mask layout and values to be entered differ depending on the used standard. 
 

 
 

The general presettings of the mask are as follows: 
• Name of the logic group 
• Manufacturer of the evaluation logic 

o When Siemens is selected, the corresponding Siemens evaluation 
units are recommended with the safety-relevant data. 

o When Third-party manufacturer is selected, the safety-relevant data 
of the evaluation logic can be freely entered. Details on the Third-
party manufacturer are provided in Chapter 3.4.8  

o   
• Next, fill in all fields. Help is provided by the tool tips on the fields and via the 

 button. 
 
Then, select the Actuator – group in the navigation tree under REACTION. 
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3.4.11 Actuator Group (Drive) Editing 

In the Actuator group mask, the properties of the safety function’s actuator (e.g. line 
contactor, failsafe drive) have to be defined.  
The mask layout and values to be entered differ depending on the used standard. 
 

 
 

The general presettings of the mask are as follows: 
• Name of the actuator group 
• Type of the actuator 

o Customer data required (electromechanical component) 
o SIL / PL exists (electronic component) 

• Manufacturer of the actuator 
o When Siemens is selected, the corresponding Siemens actuators 

with the safety-relevant data are recommended. 
o When Third-party manufacturer is selected, the safety-relevant data 

of the actuator can be freely entered (e.g. with non-Siemens 
components). Details on Third-party manufacturer are provided in 
Chapter 3.4.8  

• S7-Connection (only actuators without Integrated communication 
connection) – in this field, you can specify whether the actuator is connected 
to a failsafe PLC via a failsafe digital output module. Upon activation, a sub-
system or SRP/CS is automatically created for the failsafe digital output 
module under EVALUATION. 
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Next, fill in all fields. Help is provided by the tool tips on the fields and via the  
button. 

o For SINUMERIK 828D, SINUMERIK 840D sl and the modular fail-safe 
drive systems SINAMICS S110, SINAMICS S120 AC/AC and 
SINAMICS S120 modular, from Version V2.0 of the Safety Evaluation 
Tool, a wizard is available, which supports you when selecting safety-
relevant components. It goes without saying that the required 
components can also be directly selected as before. 
 
The selection Wizard is opened by clicking on the symbol .  

 

 
 

o The dialog that is now displayed allows a structured selection of the 
relevant system components (here, using the selection screen form 
for SINAMICS S110 as example). Please note that when opening the 
dialog again, the previously entered information is no longer available. 
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The dialog also checks whether all of the required system components 
have been selected. As long as this is not the case, the following 
message is displayed, and the system prevents the dialog from being 
exited. 

 

 
 
o As soon as the selection has been completed, after pressing the 

 buttons the dialog is closed and the selected components 
appear in the project tree below EVALUATION or REACTION.  

o Under NAME now allocate the appropriate designations for the 
automatically inserted partial systems and/or SRP/CS corresponding 
to your particular system or machine – and then complete the entries 
by editing the fields in yellow with the "Please choose" text. 

Note The Safety Integrated Basic Functions of the drives do not require an encoder. In 
this case, for encoder system you must select "No encoder required". This 
selection only serves to complete the check. As a consequence, after exiting the 
dialog, an SRP/CS is not created. 

On the other hand, selecting "Sensorless motion monitoring" simultaneously 
includes a PFH value. After exiting the dialog, a partial system or SRP/CS is 
created for this purpose. 

 
The selection wizards for SINUMERIK 828D, SINUMERIK 840D sl and for SINAMICS S120 
modular in principle has a similar structure. However, here you can also enter the required number 
for most system components. 
 

Note The selection Wizard for SINAMICS S120 modular includes basic plausibility 
checks, e.g. whether the number of selected encoder systems matches the 
number of Motor/Power Modules. 

It cannot replace the SIZER engineering tool in which the complete system 
knowledge is saved. 

 
Then, select the safety function level, in this example Emergency Stop, in the 
navigation tree for display of the calculation result. 
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3.4.12 Result   

The result of the safety integrity consideration is displayed in the overview mask of the 
safety function, in this example Emergency Stop, in the form of the Achieved SIL or 
PL and Achieved PFHD.  
The mask layout red differs depending on the used standard. 
 

 
 

Note In the masks, the calculation results are only displayed with two decimal places. 
However, the Safety Evaluation Tool internally uses more than two decimal 
places. 
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3.4.13 Report Creation 

To generate the result report, select the respective project in the navigation tree, in 
this example Company XY, and the operate the Create report button. 
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4 Appendix 
4.1 References 

This list is by no means complete and merely represents a selection of suitable 
literature. 
 

Subject Title 

Basics Reference book: Functional Safety of Machines and Systems 
Order No.: A19100-L531-B123  
(can be ordered via your SIEMENS contact partner) 

 

4.2 Internet Links 

Subject Title 

Safety Evaluation Tool http://www.siemens.com/safety-evaluation-tool 
Safety Integrated 
website http://www.siemens.com/safety-integrated 

E-mail address of the 
Safety Evaluation Tool 
Customer Support 

set.industry@siemens.com 

B10 values for 
Siemens components 

https://www.automation.siemens.com/mcms/safety-
integrated/en/machine-safety/safety-
standards/Documents/E20001-A230-M103-V4-7600.pdf 

MTBF value for 
Siemens components 

The corresponding values are also available on the CS Internet 
pages (search term: MTBF) 
https://support.automation.siemens.com 

 

4.3 History 

Version Date Modification  

V1.0 April 2009 First issue 
V2.0 June 2011 Update for SET V2.0 
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